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What’s New 

Cyclone 3DR 2024.0.0 is a major release that includes a new Plant Edition and option, and new features 

and improvements to the product, for both the Desktop and Touch Mode interfaces. The main changes 

and new functions are summarized here: 

 

▪ New Plant Edition 

• Migration of the Tank Inspection workflow into the Plant Edition 

• Restructuring of the 3DR Editions 

▪ Scan to Pipe [PLANT]: New feature to deliver BIM/CAD models for any piping application 

▪ BIM Analysis enhancements [AEC or PLANT] 

• BIM Import simplification 

• Progress Monitoring upgrade 

• Visual Notes  

▪ Support of scanner trajectories [STANDARD] 

▪ New profile extraction and analysis experience [SURVEY, AEC] 

▪ New image navigation experience for static and mobile scanners [STANDARD] 

▪ Scan to Plan Improvements [AEC] 

• Compatibility with Jetstream scans (LGSx, Cyclone ENTERPRISE, …) 

• Support of arc drawing 

▪ And various new features: 

• New Quick Plane-Plane measurement tool 

• New classification models 

• New point Cloud metadata display features 

• Multiple 3D Scene enhancements: camera synchronization, skybox background and more 

• “Filter ghost objects” capacity within Smart Texture 

• Edit Mask of images for texturing application 

• New user-friendly dialog capacity from scripting  

 

According to the maintenance expiration date policy, users under maintenance on 17 December 2023 may 

access version 2024.0 with no new license required. 
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New features 

Plant  Edition 

The most significant change within Cyclone 3DR 2024.0 is the release of Cyclone 3DR Plant Edition, which 

replaces the Tank Edition. Cyclone 3DR Tank Edition has been phased out and is no longer available from 

1 January 2024.  

New licensing structure 

Cyclone 3DR Plant can be purchased as either an option or as an Edition.  

 

Plant Option is automatically included in Cyclone 3DR Pro Edition. Pro users with a valid maintenance 

automatically benefit from all Cyclone 3DR Plant Edition features. 

 

Tank Edition is phased out and all Tank users with a valid maintenance benefit from an automatic migration 

from Tank to Plant. Note that the Tank Inspection workflow remains in Cyclone 3DR and the commands 

are part of the Plant Edition. 

 

Main features of the Plant Edition 

The main features of the new Plant Edition are: 

▪ All Cyclone 3DR Standard features and capacities (regular cleaning, meshing, modelling, 

inspection and reporting tools) 

▪ The API-653 Tank Inspection workflow 

▪ Scan to Pipe, a new 2024.0 feature to deliver Mesh/CAD/BIM Piping models 

▪ Point Cloud Automatic Classification and all models (Outdoor, Indoor, Road, …) 

▪ CAD and BIM Import capacities 

▪ CAD and BIM analysis tools: Compare/Inspect, Clash, Inspection Notes 

▪ Visual Notes, a new 2024.0 feature to deliver pre-filled reports based on visual analysis, 

compatible with BCF issues 

 

The detailed features are described in the online Cyclone 3DR technical-specification documentation. 
 

  

https://leica-geosystems.com/-/media/files/leicageosystems/products/datasheets/leica%20cyclone%203dr%20tech%20spec%20903874%200423%20en%20lr.ashx?la=en&hash=35A1E360CFA313C650C76FBCB26CBFA0
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Extract > Scan to Pipe 

Scan to Pipe is a new workflow exclusive to Cyclone 3DR Plant Edition which establishes the Plant-specific 

application. All Plant applications can be addressed with this feature: Oil and Gas, Food and Beverage, 

Chemical, Pharmaceutical and more.  

 

Scan to Pipe is a new feature that enables users to deliver piping models from any kind of point cloud. The 

applications are various from the as-built model: reverse engineering, renovation, change management, 

clash analysis, digital twin modeling and flow measurement.  

 

Scan to Pipe has been designed to support all type of laser scanning sensors. That means that all Leica 

Geosystems scanners can be used in the purpose of delivering a piping model out of Cyclone 3DR. The 

most important factor for the pipe extraction operations is coverage. With high-end sensors (P-series or 

RTC360), the best extraction can be obtained and it can require lots of scan positions. A more efficient 

scanner (BLK2GO, BLK2FLY) can be positioned for Scan to Pipe jobs since it has the ability to capture 

the scene easily through movement of the capture tech for full coverage. 

 

In Cyclone 3DR 2024.0, the piping models that can be exported are composed of segments, reducers and 

elbows. More objects will be supported in the future. 

 

Scan to Pipe is easy to use. After selecting the input point cloud, it is necessary to open the Extract menu 

and to click on Scan to Pipe. 

▪ The workflow is composed of two steps, Extraction and Export, that are detailed below. 

▪ As all Cyclone 3DR workflows, it is possible to save and quit the Scan to Pipe project and to restart 

the workflow later. 

▪ Usual tips for Cyclone 3DR extraction feature: 

• Activate a limit box before executing the feature. The limit box can be edited with the 

CTRL+SPACE shortcut during the workflow. 

• Pick the appropriate point cloud representation before (or edit it later) 

• Benefit from visualization improvements of Cyclone 3DR, it is possible to active a multi-view 

session on multiple screens, to use the synchronization of camera views and also to use the 

laser scanner image to improve the experience and the understanding of the reality. 

 

An online How To Guide will be available and Cyclone 3DR YouTube channel is completed with detailed 

tutorials about Scan to Pipe. 

 

This feature is available to users with the Plant or Pro licenses. 

 
  

https://www.youtube.com/@LeicaCyclone3DR
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Extract pipes 

Once the workflow is started, the extraction step can be executed. 

 

 
 

1. Workflow ribbon: showing the 2 steps of the workflow. It is possible to switch from one step to 
another one from the ribbon. 

2. Dialog: to manage visibility of objects

 
a. The visibility of the input point 

cloud, including the 
transparency. 

b. The visibility of the output pipes, 
including the transparency. 

c. The list of the extracted pipe 
traces with the possibility to 
control the visibility and the 
colour and the potential removal. 

 
 

 
3. Instructions: the content of the instructions evolves in a dynamic manner depending on the 

context 

4. Extraction toolbar: 

The core of the extraction process resides in the toolbar. The toolbar is dynamic depending on the object 

selected or the stage of the workflow. 

 

 
 

▪ Start new pipe trace: click to begin a new trace. The pipe trace creation is detailed below. 

4 

1 

2 
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▪ Continue pipe trace: a pipe trace extremity must be selected to continue a trace. Note that the 

tool is intelligent enough to extend a trace at the best extremity without asking the user to select 

one of them. 

▪ Connection tools: with elbow / with reducer / with straight pipe 

• Select first object 

• Click on the appropriate connection mode depending on the situation 

• Click on the second object to connect 

 

Note that a connection can work only when it is realistic. Unrealistic connections are detected and 

not created, the user will be notified of the failure. 

 

 
The 2 segments will be connected with an elbow. 

 

How to create/edit a trace? 

• The very first step for a pipe creation is the creation of a straight pipe (or segment). That is 

why this mode is automatically activated and two clicks are required to extract the first straight 

segment. 

 

 
Toolbar for the first pipe extraction 

 

▪ It is recommended to execute the 2 clicks to begin an extraction in areas where the point 

cloud density and quality are as good as possible. 

▪ Note that for all pipe extraction, the diameter of the trace can be locked and defined by 

the user. This option is extremely useful when the user knows the type of pipe he is 

extracting as it consolidates the extraction process. 
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▪ Just after the semi-automatic extraction, a heatmap point cloud is visible around the 

extracted pipe to highlight the points that are used for the extraction and the average 

deviation between the cylinder and reality. It is a useful guide to make the extraction 

process accurate. 

 

 
Extraction of the first straight pipe of the trace 

 

When the pipe trace is started, the extension mode is activated for selection: 

• Elbow + straight pipe: most common usage due to the nature of pipe networks 

▪ Activate the mode 

▪ Lock the elbow angle parameters (optional) 

 

 

▪ Pick 2 points on the next straight segment 

▪ Click ENTER 

▪ Repeat with next straight segment or change the mode or valid the pipe trace. 
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2 clicks are required to extend the trace with a segment and an elbow 

 

• Reducer + straight pipe: that works in a similar way 

▪ Activate the mode 

▪ Define the reducer parameters (optional) 

 

 

▪ Pick 2 points on the next straight segment 

▪ Click ENTER 

▪ Repeat with next straight segment or change the mode or validate the pipe trace. 

 

 
2 clicks are required to extend the trace with a segment and a reducer 

 

• Straight pipe: can extend a pipe work from segments, reducers or elbows 
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▪ Activate the mode 

▪ Define the diameter parameter (optional) 

 

 

▪ Pick 2 points on the next straight segment 

▪ Click ENTER 

▪ Repeat with next straight segment or change the mode or valid the pipe trace. 

 
 

How to edit a single component? 

 

Just after the creation of a new component or when selecting it later, it is possible to edit the object’s 

geometric parameters. 

• Straight pipes 

▪ Arrows are displayed at the extremity of the object. It can edit the length of the straight 

part while maintaining connectivity with the other elements. 

▪ Diameter: the value can be edited from the dialog. Note that when a diameter is changed, 

it impacts the entirety of the sub-part of the trace with the same diameter (until the next 

reducer). 

 

 
 

• Reducers: like straight pipes, the 2 diameter values can be edited, and the arrows give the 

opportunity to adjust the length of the reducer. The offset can also be edited but only if the 

reducer has one free extremity. The offset value is 0 if the reducer is a symmetric one. 
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• Elbows: 

▪ Can be edited with a transversal arrow to adjust the bend radius. 

▪ Can be edited from the diverse fields in the dialog (diameter and bend radius) 

▪ Angle can also be edited but only if the elbow has one free extremity. 

 

 
 

Important notes: 

 

• For all those objects, the TAB shortcut enables the modification of the numerical values 

(length or bend radius). 

• When editing a diameter of a single object, the entirety of the sub-part of the trace with the 

same diameter (until the first connection with a pipe reducer) is changed as well. 

• When 2 connected objects have a different diameter, a reducer is required to create the link. 
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Example of a chemistry plant site extracted from 3DR Scan to Pipe 

 
 

Export pipes 

The second step Export pipes is illustrated below: 

 

 
 



 

 

 

 

Two sections compose the command: 

 

▪ The list of the components of the project 

• It classifies by traces that include the 

sub-components: straights, elbows 

and reducers 

• It allows the edition of the names of 

the components and the thickness of 

the pipes. 

• Multi-selection is possible for the 

edition of the pipes. 

▪ The types of export among the choice 

BIM, Mesh, CAD and Center Axis. They 

are explained below. 

 

▪ BIM: 

• Purpose: Deliver the most intelligent BIM model from Cyclone 3DR with metadata including 

the type of object for each component: 

▪ IfcFlowSegment for straight pipes 

▪ IfcFlowFitting for reducers and elbows 

• Format: IFC 

• Options: The user can check which kind of pipe model is exported between cables, pipes and 

ducts 

 



 

14 
 

 

Piping network created in Cyclone 3DR and imported in an IFC viewer 

 

▪ Mesh: 

• Purpose: Benefit from Cyclone 3DR flexibility to deliver realistic mesh model to 3rd party 

applications 

• Format: main supported formats from Cyclone 3DR (DXF, STL, OBJ, GLB, FBX) 

• Options: SEND TO CAD feature 

• NOTE: for more advanced usage, it is also possible to go further in Cyclone 3DR outside the 

Scan to Pipe workflow, to apply a texture on the model or to execute a QA/QC heatmap 

analysis from the extraction and to share the results to formats that support textures and colors 

like OBJ, GLB or FBX. 
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Same piping project textured with the point cloud RGB colors 

 

▪ CAD 

• Purpose: Deliver CAD compatible to multiple third-party industry software solutions 

• Format: IGES, STEP 

• Options: NONE 

 

 

Same piping project exported to CAD Model 
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▪ Center axis 

• Purpose: Deliver a polyline-based model to offer a guide for isometric model creation and 

remodeling in third-party applications 

• Format: IGES, STEP 

• Options: NONE 

 

 

Same piping project exported to Center-Line Model 
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LGSx Format 

Introduction of LGSx format 

With the version 2023.1 release of the below-listed Leica Geosystems reality capture software, Leica 

Geosystems has begun an investment into a new, next-generation reality capture data model that is 

expected to mature into a new gold standard for reality capture projects.   

 

The Leica Geosystems reality capture data model powers applications like Cyclone REGISTER 360 PLUS 

and Cyclone ENTERPRISE as well as the new LGSx file—the evolution of the popular LGS file. The update 

provides a next-generation solution that includes significantly faster writing (publishing), higher 

compression, a new visualization experience, and a new core data architecture. The data architecture 

change is instrumental to allow Leica Geosystems to build out exciting new capabilities and features in the 

future to meet the growing needs of the reality capture industry.   

 

Examples of new features that are now possible to build into future software updates, and are planned as 

such, include, but are not limited to, enabling time-saving “Save” actions when editing an LGSx file with no 

need for full file copy via “Save As”, file versioning and histories (e.g., track edits to GeoTags, markups, 

etc. with options to “restore” from the version history), enhanced model and mesh support, and much more. 

Moving forward, the LGSx format will be opened by any of Leica Geosystems’ reality capture office and 

cloud apps, bringing consistency for seamless operations and workflows across multiple industries.  

 

With this release, LGS files will no longer be published by any of the below listed products though they will 

still be consumed. It is recommended that all products be updated in synch to ensure a seamless workflow 

transition.  

 

Applications included in this update:  

 

▪ Cyclone REGISTER 360 PLUS 2023.1  

▪ CloudWorx 2023.1 suite  

▪ TruView 2023.1   

▪ Cyclone ENTERPRISE 2023.1  

▪ TruView Enterprise & TruView Cloud 2023.1  

▪ Reality Cloud Studio, powered by HxDR  

▪ NEW: LGS File Converter 2023.1 (free LGS-to-LGSx conversion utility with batch conversion 

ability)  

 

Applications which will soon support the LGSx file:  

 

▪ Cyclone 3DR  

▪ Cyclone Pegasus OFFICE  

▪ Map360  

▪ Infinity  

 

Consequences for Cyclone 3DR 

Cyclone 3DR 2024.0 is updated to support the next generation of laser scanner data format “LGSx” for 

enhanced collaboration through the whole Leica Geosystems Reality Capture portfolio. With this change. 

Cyclone 3DR will continue to import LGS and now import LGSx as well. Export is now limited to LGSx. 

Certain new features described below are available only when working with LGSx such as the set of images 

or the scan trajectories. 
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Detailed explanation in the following section of the release notes: Erreur ! Source du renvoi introuvable.. 

 

▪ LGS import is still supported in Cyclone 3DR 2024.0 to allow users to benefit from a transition 

path. Even though the usage of the new LGSx format is strongly recommended to benefit from 

better performance and reduced size of the data. 

▪ LGS export is not supported anymore and replaced by LGSx, now democratized in all Leica 

Geosystems products. 

 

Extract > Scan to Plan Updates 

Scan to Plan feature that conducts the extraction of floorplan and building section from point clouds is 

upgraded in Cyclone 3DR 2024.0 with two main new features: 

▪ The capacity to extract plans directly from JetStream point clouds (mainly LGSx and Cyclone 

ENTERPRISE point clouds) 

▪ The possibility to extract and edit arcs. 

 

This feature is available to users with the AEC or PRO licenses. 

 

Direct extraction on JetStream point clouds 

Scan to Plan can directly be used on native JetStream point clouds, via LGS/LGSx files or connections to 

Cyclone ENTERPRISE, Cyclone REGISTER 360+, Cyclone CORE or JetStream ENTERPRISE. The 

benefit of this new capacity is time saving because users save a conversion step in Cyclone 3DR and the 

possibility to work on a very large point cloud. 

 

To execute Scan to Plan, it is just necessary to select the object in the treeview or in the 3D scene and to 

execute Scan to Plan from the Extract menu. 

 

New arc-drawing feature 

This new drawing capacity is available within two features: 

▪ Scan To Plan workflow in the Extraction step, which is the main application 

▪ Edit Polylines to create arcs for planar polyline edition 

 

During the edition of the polyline, a new “arc” extension feature is visible in addition to the other extension 

possibilities. Two different modes are exposed to users and can be toggled with the SPACE bar (see 

instructions below). 

 

 

 
 

 



 

 

 

The “3 points” arc method requires 2 additional clicks from the extremity of the polyline segment. 

 

    
 

The “Tangent” arc method requires 1 additional click from the extremity of the polyline segment and the 

arc curve direction is tangent to the latest segment: 

 

   
 

This new feature gives users the capacity to deliver more complex floorplans and sections: 

 

 
Floorplan from an office building captured with BLK2GO 

and extracted with the upgraded Scan to Plan in Cyclone 3DR 2024.0 

BIM Model > Import and Edit IFC File Updates 

With the 2024.0 release of Cyclone 3DR, the BIM workflow becomes more intuitive with multiple updates 

that have been brought to the Import / Edit feature of BIM Model in the application. 

 

The BIM Project management tool is automatically displayed after the import of an IFC Model or can be 

opened from an existing BIM Model object in the Cyclone 3DR Project from the contextual menu (Edit) / 

from a double click operation. 
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New BIM import and editing functions reduce the number of clicks and operations inside and outside the 

commands. 

 
1. Layout management: it is a notable change for the BIM Experience in Cyclone 3DR. Users have 

now the ability to display two kinds of layouts when manipulating a BIM Model. It is possible to 
expose the model contents according to the Levels or to the Types of objects. 

As an example, to achieve the analysis of columns only for a construction site monitoring, this new 
way to expose the BIM Model is very convenient and makes the selection faster. 

 

2. New filtering tools by level / object type: in addition to the layout management, the 2 new 
filtering tools make the appropriate selection of objects faster and easier. The combination of the 
2 filters can be useful for a straightforward workflow, for examples to select MEP Duct objects of 
Level 2. 

 

3. Visibility of project environment: to toggle the visibility of the other objects that were visible 
when the edition was started. Useful when a point cloud is also in the 3D Scene. 

1 

2 

4 

3 
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4. Undo/Redo capacity: useful improvement to adjust the edition of the selection of loaded objects 
to smooth the operation. 

 

The new user interface for BIM Edition is only available for IFC models. For RVT models, the previous 

interface is exposed. 

 

This feature is available to users with the AEC or PLANT or PRO licenses. 

 

Analysis > Visual notes 

Introduction 

 

With Cyclone 3DR 2024.0, a new type of reporting feature is enabled with Visual Notes in the Analysis 

menu. Visual Notes is a command that does not require any inputs and that gives the users the capacity 

to automatically build a report based on their visual analysis of the 3D data. 

 

This feature can be used for multiple applications and has the following benefits: 

▪ It works with any type of visible objects in the 3D scene. The immediate strength of this feature is 

to create visual notes based on the visualization of JetStream point clouds (LGSx / Cyclone 

ENTERPRISE) or Reality Cloud Studio data, directly streamed into Cyclone 3DR. 

▪ It provides lots of flexibility because it is possible to quit and restart the visual analysis, to change 

the visible objects and their representation settings. 

▪ It’s been designed with a BIM focus since the feature is compatible with BIM Model information 

and is capable of storing the GUID information from the BIM components, with the purpose of 

creating BCF notes, for a complete open-BIM workflow. Even though, note that the usage of 

Visual Notes to create intuitive report is not limited to BIM applications. 

▪ The note experience is unchanged from the Inspection Notes feature since: 

• The notes can contain information (title, GUID of BIM object, level of criticality, description, 

assignment), screenshots, images and labels. 

• The feature is BCF-compatible as soon as a BIM object is visible and can be clicked in the 3D 

Scene. 

• A new summary of notes at the beginning of the report, that is also deployed in the existing 

feature Inspection Notes. 

• A Visual Notes project can be closed, opened and updated multiple times. 

 

▪ Visual Notes embeds lots of new experience tools that are described in the release notes: 

• The management of the transparency of point clouds and models within the command. 

• The capacity to create small limit boxes to offer a better visibility of the area, which is 

concerned by the analysis. 

• A 2D-analysis experience with default visualization of the 3D environment in 3D View / Top 

View / Side View to create measurements of distance. 

• A new Quick Plane-Plane measurement tool to make horizontal and vertical measures, also 

available as a quick tool, out of Visual Notes feature. 
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This feature offers a new experience to report issues that inspection colormap cannot explain, in particular 

to report significant gaps between a design model and the reality. Some examples are suggested: 

▪ A steal column is rectangular instead of a H-section type. 

▪ A pipe is 25cm shifted from the design position. 

▪ A duct has been built with a 200mmx200mm rectangular section instead of a 150mm diameter 

circular section. 

▪ The opening of the wall is missing. 

 

Consequently, Visual Notes is complementary to Inspection Notes, and they are differentiated according 

to the following explanations: 

 

Menu Inspection Notes Visual Notes 

Main Goal 

Create BCF notes or an automatic report 

based on a deviation analysis of BIM 

Model. 

Create BCF notes or an automatic report 

based on the visual analysis of the 3D data. 

Adapted to BIM application 

Mandatory 

input 
An inspected BIM Model N/A 

Point Cloud 

specific 

The BIM inspection has to be previously 

created from a 3DR point cloud. 

The visual analysis can be done on a 

streamed point cloud like LGSx or a 

Reality Cloud Studio. Useful to work on 

heavy datasets. 

Level of 

accuracy 

Relevant for high-standard deviation 

analysis (millimetric precision) 

Relevant for analysis that requires human 

skills to understand issues 

Use cases As-Built Verification 

Preparation of a renovation project / 

Consolidation of a digital twin / As-built 

Verification 

Example 

Accurate analysis of structural component 

Report the fact that a column is deviated by 

3mm and make multiple deviation labels 

Visual analysis of MEP installations 

Report a duct that is 25cm shifted from the wall 

and that has wrong dimensions too 

Sensors 

Static sensors (RTC360, BLK360) are 

recommended for the most precise 

deviation reports. 

Mobile scanners (mobile BLK series) are 

ideal to get fast and accurate reports. 

Deliverables 
Automatic report (Summary presentation + Detailed notebook of issues) to PDF, CSV 

or BCF (open BIM standard). 

 

This feature is available to users with the AEC or PLANT or PRO licenses. 
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Start a report of notes 

 

Prior starting the creation of notes, there are recommendations: 

▪ Make visible the objects that are necessary (typically the reality and the design model) and adjust 

their representations for the best 3D experience as possible. 

▪ Display a BIM Model to allow the creation of BCF notes (references to GUID values). 

▪ Activate a limit box that can edited with CTRL+SPACE inside the command. 

▪ Execute Visual Notes from Analysis menu. 

 

Here is the window of the main interface of Visual Notes: 

 

 
 

1. List of notes and output options: 

• Notes can be reviewed, edited or removed from the list. 

• Output options contain: a direct update of the main report view and a direct export of the notes 

to BCF format. 

 
2. Note toolbar: 

 

• The possibilities are similar to the existing Inspection Notes toolbar. 

• The Add Note feature requires next a click on any object in the 3D scene to create a 

georeferenced note. To create a BCF-compatible note, it is mandatory to click on the design 

BIM Model. 

• The Add Measures (Visual Notes) tool replaces the Add Labels (from Inspection Notes) to 

let the user make 2D measurements. This aspect of the workflow is the most significant change 

from the Inspection Notes experience and is described in more detail later. 

1 

2 
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• The Edit Info feature displays a pop-up dialog with all the information that can be edited by 

the user to bring the necessary fields for a BCF workflow or to bring intelligence to the report. 

 

 
 

 

Add 2D measures in a note 

 

 
 

 

 

1 

3 

2 
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1. Dialog for: 

• The visibility management of the inputs including transparency of point clouds and models. 

• The list of measurement labels created in the note. 

 
2. Presentation of the 3D Scene in 3 parts: 3D View / Top View / Side View 

• As soon as the Add Measure mode is active, the 3D Scene is automatically split in 3 parts to 

offer the best experience as possible to create 2D measures. 

 
3. Measurement toolbar: 

• This new toolbar is a toolset that allow users to create 2D measurement labels and 

screenshots. It gathers different new features to improve the note experience. 

 

 
 

• Add Limit box is a user-friendly smart limit box that can help to have a focus on the area of 

the note to report the specific issue/clash/situation. 

 

 
 

▪ Automatically, the limit box is active on the Top and Side Views to show the clipping 

impact on the environment. 

▪ A user action is required to Validate or Cancel the limit box, as illustrated above. 

▪ The size of the limit box is predefined to have a focus. It can be edited before validation 

with CTRL + Scrolling action. 

▪ After validation, it can be edited as usually with the regular CTRL+SPACE shortcut. 
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• Add Point to Point distance labels: Quick 2D measurements between 2 points 

• Add Plane to Plane distance labels: New quick 2D measurements between 2 planes to 

consider the normal direction of the planes, but also to force the measurement along the main 

vertical and horizontal directions. This new tool is described in the Quick measure > Distance 

between planes section of the release notes. 

 

 
 

• 3D / Top / Side buttons: once the 2D measurements are done, it is possible to add 

screenshots to the note. 

• View Gallery: Direct verification of the created screenshots. 

• OK: to validate the measurements and the contents of the note. 

 

How to publish a report 

 

The mechanism is similar to the existing feature Inspection Notes and there are two possibilities: 

▪ Export BCF issues: the BCF export is directly accessible from the Visual Notes feature and gives 

the possibility to save a single BCF file that will contain all the notes and their assets, to share the 

results from the analysis to a third-party BIM management platform. 

▪ Create a PDF report from the Report Editor that contain: 

• A high-level summary of the analysis containing: 

▪ The main viewset of the project 

▪ The summary table of all the notes including index, titles, description, priority, assignment, 

… This table can also be exported to CSV. 
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• A collection of notes based on the executed analysis. For each note, the report exposes 

multiple pages with the information and the assets created by the user: 

▪ The note information like object, priority, assignment… 

▪ All the saved viewsets to illustrate the note and showing the 2D measurements. 

▪ The labels corresponding to the 2D measurements. 

▪ The attached images by the user. 

 

 

 
Example of an issue in the structural design explained with 2D measurements to illustrate the gap 

between the design model and the reality for the dimensions of the steal column 
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Analysis > Progress Monitoring Updates 

The Progress Monitoring feature dedicated to the construction industry benefits from very interesting 

improvements in Cyclone 3DR 2024.0. The purpose of the updates is to improve the accuracy of the results 

by: 

▪ Leveraging existing capacities for the computation, like the classification information and deviation 

analysis improvements 

▪ Enriching the report information with a single user-click for PDF and BCF export 

 

As a reminder, the Progress Monitoring feature is a BIM-analysis tool that: 

▪ Takes a point cloud and a BIM Model as inputs. 

▪ Offers a wizard-workflow experience in 3 steps: Analyze > Check > Export. 

▪ Delivers progress report for construction site application mainly to PDF, CSV or BCF. 

▪ Is ideal with BLK2GO / BLKARC scanner to get fast results from field to decision. 

▪ Can be deployed for construction progress purpose but also for invoicing management, sub-

contractor control, maintenance, construction verification, … 

 

This feature is available to users with the AEC or PRO licenses. 

Integration of classification information 

The Cyclone 3DR 2024.0 Progress Monitoring version now benefits from a direct link with classification 

information. This improvement remains optional but can significantly improve the results from the Progress 

Monitoring for many applications. 

 

To optimize the report with the classification, it is mandatory to classify the input point cloud first with the 

updated version of the Indoor Construction Site Model, that also benefits from interesting enhancements 

in particular for linear objects like beams, columns, or pipes/ducts (more information in the Indoor 

Construction Site section). Before executing the Progress Monitoring command, it is important to keep 

unchanged the indexes of the point clouds classes to allow the command to make a match between the 

points and the appropriate classes. 

 

Once in the first step Analyze of the workflow, a new option “Optimize with Indoor Construction Site 

classes” is exposed so the use of this option is straightforward.  

 

▪ If the option is selected, the algorithm will make a more intelligent match between some objects: 

• Points of walls with Ifcwall type of object (and equivalent) 

• Points of ceilings and floors with Ifcslab of object (and equivalent) 

• Other points with other types of objects 

This level of categorization provides an efficient way to split many components from large 

surfaces like walls or slabs. 

▪ If the option is not selected, the computation will be based on the geometric comparison between 

the point cloud and the BIM Model. 

 

Note that: 

▪ This new option barely decreases the computation performance of comparison between the scan 

and the BIM Model. The difference cannot be perceived. 
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▪ When the option is checked, the representation of the point cloud automatically switches to 

Classification to let the user visualize the appropriate classes. 

▪ Like all BIM analysis in Cyclone 3DR, it is appropriate to adjust the contents of the analyzed BIM 

model to focus only on the scope of interest and to optimize the results. 

 

 

Computation improvements 

More computation improvements are also part of the upgraded version of Progress Monitoring. They are 

independent from the selection of the new option to optimize with classification. They appear in the 

backend of the process and are not visible to the users.  

 

The main improvements are: 

▪ Removal of the “edge effect” for large objects like walls or slabs for example. The points, close to 

the edges of large components, are considered in the computation to reduce false positive effects. 

▪ Integration of surface orientation in the computation: this algorithm improvement part of 3DR is 

deployed into Progress Monitoring to improve the match between surfaces. 

▪ Optimization of the “resolution” value according to the type of objects: 

• The resolution option remains exposed to the users and defines the maximum size of the 

triangles of the inspected model. 

• But for many objects, the maximum size is optimized to automatically improve the outcome 

from the computation and the resolution is object-defined for walls, slabs, columns, pipes, 

beams, pipes, … 
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New report contents 

With Cyclone 3DR 2024.0, the contents of the report from Progress Monitoring analysis are significantly 

richer to offer the more complete and accurate analysis experience for BIM applications. 

 

  
 

 

 
1. Preview of the progress status 

distribution: unchanged 

 

2. View settings 

▪ To update the main view of the 
report. 

▪ To define the unit of the inspection 
analysis in the report. 

 
3. Detailed report options: New option to 

create a very complete report, described 
below. A Compute button is required to 
generate the report, that can be very 
heavy since multiple images are created 
for all isolated BIM components. 

 
4. BCF Export options: unchanged 

 

 

 

 

 

 

 

 

 

2 

3 

1 

4 
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Concerning the detailed report features 

▪ The options are exposed only when the checkbox “detailed report” is selected. 

▪ In the list of issues, it is mandatory to select which components will have a detailed analysis 

depending on the application and the choice of the user. 

 

▪ Note that the size of the report can be massive with lots of images for each component, 

which is why: 

• A notification is displayed to warn the user when there are more than 100 components. 

• A “compute” action is required to execute the generation of the report. 

▪ The detailed report applies both for the BCF tickets and in the PDF report. 

▪ The results from the detailed report are for the PDF two additional pages that contain: 

• A summary about the object (properties and main results from the analysis like the coverage 

value, the progress status, …) 

• A map based on the input BIM Model and the location of the object. 

• 4 side images showing the deviation between the BIM component and the point cloud. 

• A section view to highlight the visual difference between the design model and the reality. 

 

 
Report extract of a column that is installed but slightly shifted from the design model. 
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Report extract of a pipe-flange with a ~3 cm shift to the top in comparison to the design model 

 

On top of the additional detailed contents, the report benefits from a summary for the project that can be 

exported to PDF, BCF or CSV. 

 

Note that the automatic extraction of a CSV table is still available which allows lots of automation to 

manipulate the results from the BIM analysis and to create new metadata in the native BIM Model based 

on the results (via a Dynamo script in Autodesk REVIT for example). 
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Treeview updates 

After quitting the workflow and in addition to the report experience, further analysis can be achieved with 

the outputs from the Progress Monitoring feature. In the 2024.0 version of Cyclone 3DR, they are properly 

sorted to offer more flexibility and easiness to manipulate various objects depending on their status (No 

data / Not Installed / Incomplete / Installed) and their type (isolated BIM components or isolated point 

clouds). 

 

The new organization is described in the visual below. 

 

 
 
 
Indeed, in addition to the report deliverable (PDF, CSV or BCF), the output 3D objects are useful: 
 

▪ For 3D visualization and analysis of the progress monitoring in Cyclone 3DR: it is convenient to 

navigate through the 3D data to understand further the reality, to display the original point cloud 

or the native IFC model. This experience is even boosted by the all the new features related to the 

rendering, the 3D scene improvements or the modernized 3D image experience that are significant 

in the 2024.0 version of Cyclone 3DR. 

▪ For exporting 3D result from progress monitoring. The new treeview organization gives lots of 

flexibility to group and export in one mesh all the BIM components with the same progress status 

(to regular mesh format like OBJ, DXF, FBX, GLB, …). It brings the capacity to visualize the 3D 

result in third party applications. 
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In this progress monitoring analysis, only the “Installed” and “Incomplete” components are displayed to 
simplify the visualization experience. It is extremely easy to filter the components with the updated treeview 
management of the feature. 
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Scanner trajectory 

With the 2024.0 version of Cyclone 3DR, a new type of reality capture object is supported with the trajectory 

coming from the scanning operation. This new feature leverages the hardware experience and gives users 

a smooth experience through Leica Geosystems solutions and offers now much more automatic data 

processing capacities in Cyclone 3DR. 

 

This feature is available to users with the STANDARD license. 

Supported scanners 

The following types of scans can support a trajectory in the LGS/LGSx format: 

▪ Mobile BLK scanners (BLK2GO, BLKARC, BLK2FLY) published from Cyclone REGISTER 360+. 

It is mandatory to check the “Export track” option when publishing a LGS/LGSx dataset. 

▪ TRK scanners, publisher from Cyclone PEGASUS OFFICE. Trajectories are automatically 

exported within the LGS/LGSx files. 

 

New Import and Export capacities 

Import 

 

When importing an LGS/LGSx into Cyclone 3DR, a new option is exposed during the conversion step in a 

3DR point cloud. When the option is checked, all trajectories within a project are imported in Cyclone 3DR 

because clipping objects have no impact on the trajectory, contrary to points and images that are filtered 

during the conversion process by clipping objects. 

 

Note that a reality capture data from a dynamic project can have multiple trajectories, because it can store 

multiple sub-parts: like “walk” from BLK2GO, “scan” from BLKARC or “track” from TRK. 

 

After import, a new object trajectory is stored and displayed in the Cyclone 3DR project. 

 

Export 

 

The process to export a trajectory when publishing an LGSx dataset is straightforward. In addition to the 

other supported assets from Cyclone 3DR to the LGSx format (point clouds and limit boxes), select the 

trajectory before selecting Export from the File menu and selecting the LGSx format. 

 

New trajectory object and new related functions 

Trajectories are visible in the treeview and by default stored in the imported “scan” project in addition to 

the point cloud and the set of images. 

 

As described in the visual below, many properties are stored in the trajectory object. They are very similar 

to polyline objects, but they differentiate because they are strongly related with the laser scanner project 

through the two types of information: 

▪ Timestamps of the laser scanner project (Point cloud metadata display features) 

▪ Link with the scan positions and the set of images (Upgraded image navigation capacity) 
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Many existing features are compliant with scanner trajectory with a similar behavior to polyline: 

 

▪ View > Camera path: for video creation 

▪ View > Quick slice along a curve: convenient to create clipping objects along the axis of the scan 

project 

▪ Clean > Clean according to distance: to keep only the points close to the trajectory. It can be 

very efficient to get rid of noisy points for linear applications like roads or rails 

▪ Clean > Edit > Cut polyline 

▪ Surface Modeling > Extrude Profile along a path and Pipe/Tube along a path 

▪ Analysis > Compare Inspect Section vs Section 

▪ Analysis > Profile Extraction and Inspection workflows: the modernized workflows are also 

compatible with trajectories 

▪ Analysis > Unroll along axis 

 

In addition, the feature Extract polyline from trajectory has been integrated to offer even more flexibility. 

 

New script class and functions 

Useful new script functions related to trajectory objects are released to bring more automation to point 

cloud processing operations in Cyclone 3DR. They can be greatly beneficial to process very large dataset 

coming from Mobile Mapping sensors. 

 

To manipulate trajectories, a new class STrajectory has been integrated. This class benefits from the 

SComp capacities too, to manage visibility or selection of the object for example. 
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The list of STrajectory-class related functions is summarized below and all the details of the functions are 

described on the online API documentation. 

 

▪ ConvertToMulti 

▪ EstimatePose 

▪ GetDuration 

▪ GetLength 

▪ GetNumberOfPoses 

▪ GetPoseInfo 

▪ GetTimestampRange 

▪ LinkToCLoud 

▪ Save (to a CSV file) 

▪ ToString 

▪ ValuesToString 
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Modernized image experience 

With the 2024.0 release of Cyclone 3DR, a significant step forward is achieved in matter of experience 

with images from reality capture data. This main change includes a consistent experience across reality 

capture software portfolio of Leica Geosystems and it has a positive impact on the following aspect in 

Cyclone 3DR: 

▪ Representation and information of the scan positions 

▪ Simplification for large dataset project 

▪ Visualization, interaction, and navigation through images (including the scan trajectory) 

▪ Customization of texturing workflows 

 

The updates mainly cover visualization and navigation, which means that they benefit most of the Cyclone 

3DR commands. 

 

This feature is available to users with the STANDARD license. 

 

Main changes for the image objects 

Import images / Convert from JetStream projects (LGS/LGSx) 

 

When importing scan data, the experience is unchanged, and it is possible to check the type of data that 

will be imported. The import of images remains optional. 

 

In the case of the conversion of a JetStream project (LGS/LGSx usually), a new option is exposed to users 

that desire to convert a TRK scan project into Cyclone 3DR. Indeed, the side images can be imported into 

the 3DR project, which remains an optional possibility. 

 

 
 

For LGS/LGSx point cloud with a trajectory (Mobile BLK or TRK scanners), there is a specific option to 

extract camera images at a minimum step. To be defined by the user according to the targeted application 

(for example, every 2 meters for Indoor – every 15 meters for an MMS scan). 
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Representation in the 3D Scene / New scan position representation 

 

The representation of the scan positions is now similar to the other Cyclone software applications. From 

each position, it is possible to display the coordinates and the contained camera images. Indeed, each 

scan position can host multiple images, as it is regularly the case for Mobile Mapping applications. 

 

 
 

To display the scan position, the user action is unchanged. They are displayed from the View menu with 

Scan Locations command or with SHIFT+S shortcut (accessible from any command). 

 

The interaction with the scan positions is described in the Upgraded image navigation capacity section of 

the release notes. 

 

 

Set of images: new object 

 

After point cloud import (or conversion from a JetStream point cloud), a new type of object is now created 

in the Cyclone 3DR project: set of images. All the images from the scan data are gathered in a simple 

object, as illustrated below.  
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Information from the set of images can be displayed 

 

This new mechanism is extremely convenient with the trend of manipulating bigger and bigger datasets 

because the number of images permanently increases. Having a single set of images simplifies the 

experience and prevents from having thousands of image objects for Mobile Mapping applications for 

example. 

   

 
 

The “Go to camera viewpoint” feature directly changes the camera position and orientation at the first 

image of the set 

 

To manage the imported set of images, it is recommended to edit the object (double click in the treeview 

or from the contextual menu) and a new interface is exposed. 

 

 
 

1. Management tools of the images: 

a. Treeview that sorts all the images by scan position 

b. Selection capacity with a checkbox system and a filtering tool by name to define which 
images would be applied as a texture on a mesh 

2. Interaction with the 3D Scene: it is possible to select a group of images at a precise scan position 
by clicking on it in the scene 

1 

2 

3 
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3. Instructions 

 

When an image is selected, two actions are possible: 

 

 

▪ Arrow icon: ability to extract the image from the group of images 

▪ Zoom icon: when clicking on it a new interface is displayed 

 

 

 
  

   
1. Name of the image 

2. Previous/Next arrows: to navigate from 
one image to previous/next one 

3. Image details 

3 types of information can be displayed: 

 

• The preview of the image, 

• The preview of the active mask 
(for texturing), 

• The properties. 

 

 

With the introduction of “set of images”, the type of object “single image” remains in Cyclone 3DR. That 

means that it is possible to: 

▪ Import isolated images in a Cyclone 3DR and use them with usual image-related features. 

1 

2 2 

3 
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▪ Group/Ungroup set of images to create isolated-image object. 

 

How to use Set of images for texture application? 

 

The workflow with the set of images remains straightforward with the new interface to manage image 

objects: 

▪ Edit the set of images and define which images are activated for the texturing application: through 

the checkbox system or through the filtering tool. 

• The filtering tool is useful for example if only the spherical images are relevant for the texturing 

needs, with the keyword “sphere” to pick the appropriate selection. 

• The selection can be achieved directly in the tree or in the 3D scene. 

▪ Select the set of images and the mesh to texture 

▪ Execute Smart Texture or Standard Texture from the Texturing menu 

 

 

Which features are removed with Cyclone 3DR 2024.0 due to the change? 

 

With the introduction of set of images, the following features are not available anymore: 

 

▪ The images are not displayed in the 3D Scene (geo-referenced spheric and ortho images). 

▪ Consequently, there are not “bulb” anymore in the treeview to manage the visibility of the images. 

▪ The visibility of the image locations is now managed by the scan locations. 

 

Upgraded image navigation capacity 

How to go into image navigation mode? 

 

To position the camera at a scan position and in the image navigation mode, there are 2 main ways: 

▪ Make sure the scan positions are displayed (now Show scan locations is available from a toolbar 

and not the View menu anymore) and double click on the appropriate scan position. 

• Once the image navigation mode is active, it is possible to change from one position to another 

by double clicking on another position (Item 1 on the visual below). 

• SHIFT+S is a must-known shortcut because it manages the visibility of the scan positions 

when the user is using a feature (which disables the access to the view menu). 

▪ From the treeview and the representation panel of a set of images, click on Go to camera view. 

The camera will be positioned at the first scan position of the set of images. 

 

When the image navigation mode is active, the camera mode automatically switches to Panorama mode 

and a new image navigation toolbar is exposed on the top right part of the 3D scene (Item 2 on the visual 

below). 
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Image navigation toolbar 

 

 
 

1. Background/Foreground visibility management: There are 2 possibilities. The image can be 
displayed in the background of the scene or in the foreground. 

In Foreground mode, a slider is available to manage the transparency of the image. The bulb 

enables /disables the visibility of the active image. 

 

 

2 3 4 

2 

1 

1 5 
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There is no option for the Background mode. 

 

2. List of available images at the scan position 

It is common to store various images at the same scan position. 

For MMS hardware sensors, side images can be imported in addition to pano-images. 

For TLS scanners, cubic images can be imported instead of pano-images. In that situation, there 
are multiple images. 

 

3. Navigation tool – Only exposed for mobile scanner data 

The navigation tool is exposed only when the scan positions are related to a trajectory from a 
mobile scanner data (mobile BLK or TRK). It allows the user to go the previous/next scan position. 
The CTRL + Scrolling action shortcut also allows the backward/forward move to the closest 
scan position. 

 

4. Quick access to synchronized views 

A click on this button automatically splits the 3D Scene in 2 synchronized scenes: one will display 
the active image, the other one will display the 3D environment. This feature is appropriate to 
extract information on the reality and to visualize the image and the point cloud at the same time. 

The new “synchronization of 3D scenes” capacity is described in the   



 

45 
 

Synchronization of multiple 3D scenes section of the release notes. 

 

5. Show scan locations (direct button in the toolbar after the removal from the View menu) 

 

New Profile Extraction and Analysis workflows 

With Cyclone 2024.0 version, all the features in the Analysis menu and Sections group have been 

modernized. The purpose of this change is the simplification of the user experience from the selection of 

the analyzed datasets to the delivery of the report, in addition to the removal of know issues of the existing 

commands and the integration of diverse improvements. 

 

This group of commands Create Profiles along Axis, Compare / Inspect Profiles, Volume Over / Under and 

2D Preview / Export is replaced by three new wizard-workflow features: 

▪ Profile Extraction: to deliver quick CAD profiles of multiple objects (clouds or meshes) 

▪ Profile 3D Inspection: to deliver report analysis of closed objects (tunnel/pipe application) 

▪ Profile 2D Inspection: to deliver report analysis of open objects (road/plane application) 

 

 
 

The options that are part of each workflow remain similar to the previous version of the commands. 

 

Users benefit from three different methods that help them to get a more straightforward deliverable 

depending on the needs of the extraction or analysis. 

 

The benefit of having wizard-workflow features also simplifies the experience in comparison to the previous 

usage of the profile extraction / analysis: 

▪ Selection of inputs: it happens only at the beginning of the workflow, and it reduces the number 

of interactions with the treeview. 

▪ Order of execution of commands: thanks to the workflow ribbon, the execution of the tasks is 

straightforward. 

▪ Capacity to restart the workflow project: a single click allows to restart the project. 

 

 
 

The workflows are available to users with the SURVEY or AEC or PRO licenses. 
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Analysis > Profile extraction 

The purpose of the first workflow Profile Extraction is to get CAD profiles of linear projects. In that 

workflow, no report will be created, and the goal is to export to CAD / send to CAD the profiles. 

 

To execute Profile Extraction, it is necessary to select first the following inputs: 

▪ An axis: it can be a polyline or a scanner trajectory (now supported in Cyclone 3DR 2024.0) 

▪ One or a group of similar types of objects (point clouds or meshes). Part of the interesting 

improvements, this feature allows users to select an unlimited number of inputs (instead of 2 in the 

previous versions), which means that it possible to export CAD profiles of 3 scans or more. 

 

Then the required tasks remain like the previous feature and are guided to execute 4 steps: 

 

▪ Prepare 

 

 

• Inputs: to adjust visibility of objects 

and change the selection 

• Section Definition: to prepare the 

main parameters for the future 

creation of sections along the axis 

• Section Orientation: option for the 

orientation of the future sections 

The Prepare step is similar for the 2 other features Profile 3D Inspection and Profile 2D Inspection. 
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▪ Define positions, with much more flexibility with Cyclone 3DR 2024.0 

 
 

 

• Extraction method: it is first required 

to pick the appropriate method to 

position the future sections on the 

input objects. Two methods are 

possible. 

• For the Regular method, some 

parameters are exposed to 

automatically extract the sections at 

the appropriate locations depending 

on the user needs. Unchanged from 

the previous behavior of the 

command. 

 

• Insert: to add new section positions in the project, a click on the Insert button is required. 

Part of the improvements of the 2024.0 release of Cyclone 3DR, it is possible to proceed 

multiple insertions and to combine multiple methods. This feature gives users more flexibility 

and to way to refine the positions of sections according to the specifies of the environment 

As an example, a user can create sections: 

▪ from PK0 to PK100, a section every 10 meters, 

▪ from PK11 to PK19, a section every 1 meter (for example if there is turn to control or 

specific aspects to verify), 

▪ single sections at PK23.435 and PK59.748 if the user wants to have a specific focus. 

• The list of sections is filled in the dialog and can be reset as well. 

 

The Define Positions step is similar for the 2 other features Profile 3D Inspection and Profile 2D 

Inspection.  
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▪ Compute profiles 

 

 
 

 

• Maximum distance: this option is a 

way to filter areas that are far from 

the axis when the section is created. 

 

• Sections display: they are unchanged from the previous version, it is possible to: 

▪ Toggle the visibility of the 3D Scene (LEFT part of the scene) 

▪ Change the visibility of the sections (single or grouped in various representations) on the 

RIGHT part of the 3D Scene. 
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▪ Report: to directly export CAD profiles or send to CAD applications like BricsCAD or AutoCAD. 

The experience of this step is unchanged from the previous “2D Preview / Export” command. 

 

 
 

 

• Export / Report views: this section 

exposes all the parameters of the 

grids that will be exported 

• Export: DXF or Send To Capacity 

 

Analysis > Profile 3D Inspection > Tunnel and Pipe application 

The purpose of the second workflow Profile 3D Inspection is to create an analysis report and deviation 

maps for specific profiles for “3D tubular” linear projects (tunnels, pipes, chimneys for example). In that 

workflow, a report is automatically created when the user reaches the final Export step of the workflow. 

Besides, it is also possible to export the deviation maps to CAD. 

 

To execute Profile 3D Inspection, it is necessary to select first the following inputs: 

▪ An axis: it can be a polyline or a scanner trajectory (now supported in Cyclone 3DR 2024.0) 

▪ A reference model: point cloud or mesh 

▪ A measured model: point cloud of mesh 

 

Then the required tasks remain similar to the previous analysis feature and are guided to execute guided 

steps. 
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The first 3 steps are exactly similar to the Profile Extraction workflow: 

▪ Prepare 

▪ Define Positions 

▪ Compute Profiles 

 

   
 

▪ Compare Inspect 

 

 
 

 

• The options are unchanged from the 

ancient Compare/Inspect feature for 

Profile Analysis. 

• The “Compare with regular step” is a 

way to extract deviation values on a 

regular basis around the section. 
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▪ Volume Over/Under 

• A very user-friendly improvement for the 3D Analysis experience is the integration of the 

Volume Over/Under calculation in the workflow, which fluids the analysis experience. 

• This step of the workflow is optional. That means that it is possible to go to the next step of 

the workflow and to create a report without executing a volume calculation. 

• This step is exposed in the Profile 3D workflow only when 2 meshes are used as inputs for 

both reference and measured models. Indeed, mesh objects are required to compute volumes 

in Cyclone 3DR. 

 

 
 

     
 

• Part of the options, users must define: 

▪ A step along the axis, to define the resolution step of the volume difference calculation 

between the reference and the measured objects. 

▪ The scope of the volume analysis with the start and the end of the operation. 

• In the preview of the results, the total volumes are presented and the detailed volumes for 

each sub-section are exposed too. 
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▪ Export 

 

 
 

The parameters are exactly the same as the Profile Extraction workflow. 

 

▪ Report 

 

Once the workflow achieved, it is possible to open the report editor and to finalize the report to PDF and 

CSV. The representation of the profile position along the axis has been improved. 
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Analysis > Profile 2D Inspection > Road application 

The purpose of the third workflow Profile 2D Inspection is to create an analysis report and deviation maps 

for specific profiles for “2D surface” linear projects (roads, grounds, retaining walls, surfaces for example). 

In that workflow, a report is automatically created when the user reaches the final Export step of the 

workflow. Besides, it is also possible to export the deviation maps to CAD. 

 

To execute Profile 2D Inspection, it is necessary to select first the following inputs: 

▪ An axis: it can be a polyline or a scanner trajectory (now supported in Cyclone 3DR 2024.0) 

▪ A reference model: point cloud or mesh 

▪ A measured model: point cloud of mesh 

 

Then the required tasks remain similar to the previous analysis feature and are guided to execute guided 

steps. 

 

The first 3 steps are exactly similar to the Profile Extraction and Profile 3D Inspection workflows: 

▪ Prepare 

▪ Define Positions 

▪ Compute Profiles 
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▪ Compare Inspect 

 

 

 

The differences with the Profile 3D Inspection 

are: 

▪ The choice of the 2D Inspection direction 

(default is Z). 

▪ The removal of the “Ignore road” option, 

not relevant for the Profile 2D Inspection 

workflow. 

 

▪ Export 
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The parameters are exactly the same as the Profile Extraction workflow. 

 

▪ Report 

 

Once the workflow achieved, it is possible to open the report editor and to finalize the report to PDF and 

CSV. The representation of the profile position along the axis has been improved. 

 

 
 

New script functions 

To execute the Profile analysis workflows in an automated scripted way, the two existing script functions 

have been migrated to support the modernization of the workflows: 

▪ CreateCrossSections() 

▪ CompareCrossSections() 

 

 

Clean > Auto-Classification > New models 

With the 2024.0 release of Cyclone 3DR, the Auto-Classification feature is boosted with a new series of 

models for diverse applications. In addition to the existing models (Outdoor Generic, Indoor Generic, Indoor 

Construction Site and UAV Heavy Construction), new models are part of the new version: 

▪ BLK Mobile Filter People | NEW 

▪ Road | NEW 

▪ Indoor Construction Site | UPDATED 

 

The use of the Auto-Classification is unchanged and to run a point cloud classification, the workflow 

remains quite simple: select the point cloud, run the feature Auto-Classification and choose the appropriate 

model before clicking on Compute or OK. 

 

This feature is available to users with advanced licenses (SURVEY or AEC or PLANT), or PRO licenses. 
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BLK Mobile Filter People 

The purpose of this new model is to clean BLK Mobile point clouds from moving people and moving objects. 

Its usage is appropriate for any kind of application because the goal is the removal of unnecessary noisy 

points from the point cloud. 

 

The model has been trained with BLK2GO and BLKARC scanners only. It is recommended to use the 

models with point clouds scanned with these two sensors that deliver point clouds with a similar structure. 

 

Note that it is not relevant to filter BLK2FLY point cloud because the applications of BLK2FLY scans often 

cover facades or roofs and are not related to pedestrians or people that need to be filtered from the original 

point cloud. Besides, BLK2FLY sensor has not been included in the model training. 

 

 
Red points represent the moving people and objects from the indoor environment captured with BLK2GO 

 

Road 

The Road model, now part of Cyclone 3DR, offers equivalent results to the Point Cloud Classification for 

Road within Cyclone PEGASUS OFFICE. The application of this model is obviously the segmentation of 

scan data for Outdoor application with road environment. 

 

The benefit of having the Road model in Cyclone 3DR: 

▪ Give users the possibility to segment unclassified point cloud coming from any MMS sensors 

▪ Offer a classification tool that is also relevant for TLS Sensors like RTC360, P-XX series or BLK360 

Leica scanners. 

 



 

57 
 

 
 

Point cloud of a road intersection captured with RTC360, classified with the new ROAD model 

 

Indoor Construction Site 

The existing model Indoor Construction Site has been updated in the latest release and now benefits from 

a larger training base. The new model delivers a more refined segmentation of the point cloud, which 

reduces the time of manual adjustment after the automatic classification. In particular, the new model gives 

significant improvements regarding MEP and columns classification. 

 

 
 

Classified point cloud of a construction site captured with BLK2GO 
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Point cloud metadata display features 

New types of metadata 

With the 2024.0 release of Cyclone 3DR, two new types of metadata can be stored in a point cloud 

structure: 

▪ Timestamp 

• Timestamp is only provided for Mobile scanners: 

▪ MMS-like: TRK-Series 

▪ Mobile BLK: BLK2GO, BLKARC, BLK2FLY 

• This metadata can be imported from e57 and LGS/LGSx point clouds and the information is 

now saved after import. 

 

 
“Timestamps” representation of a TRK scan of a street 

 

• The support of timestamp consolidates the reality capture experience from hardware to 

software but also offers a new way to clean the data or to display the reality in Cyclone 3DR. 
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▪ Density: 

• Density of point clouds can be computed with Cyclone 3DR scripting functions: 

ComputeDensityFromNearestPoints() and ComputeDensityFromSphere() 

• The density information of each point is now stored in a new metadata. 

• Density is an interesting metadata to categorize the data and for example to clean low-density 

areas of a scan. 

 

 
“Density” representation of a TRK scan of a street 

 

 

This feature is available to users with STANDARD licenses. 

 

Scalar representation and scalar values 

Single naming for diverse information 

 

To simplify the experience of scalar metadata of point clouds in Cyclone 3R, the naming of some features 

and options have been reviewed to address the entirety of the current and future scalar information of scan 

data, such as: 

▪ Intensity values 

▪ Inspection values (from 3DR analysis) 

▪ Timestamp (from mobile sensors) 

▪ Density of point clouds (from 3DR computation in script) 
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Representation and settings 

 

The main settings for scalar representations are accessible in the point cloud settings. 

 

 
 

The diverse representation can be switched from the panel in the treeview. All the diverse representations 

are accessible. Timestamp and density are new. 
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Edition and extraction of scalar values 

 

Existing functions are deployed to all scalar values and the new Timestamp and density. 

 

To manipulate a scalar value, it is mandatory to display the point cloud in the appropriate 

representation to make it active to all the edition and extraction feature. Once the appropriate 

representation is chosen, the user can execute the following workflows: 

 

▪ Change the gradient with “Edit colors” feature 

• Through the representation panel shortcut or through the Analysis menu 

• Only the active representation will have an updated gradient 

 

▪ Split the point cloud with the existing cleaning features: 

• Clean > Scalar steps 

• Clean > Scalar range 

 

▪ Extract the metadata value into a 3DR label for information or reporting: 

• Through the quick label access on the TOP RIGHT corner of the 3D Scene 

 

 
 

Different labels extracted from the TRK scan of the road (Density / Intensity / Timestamp) 
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3D Scene Enhancements 

Cyclone 3DR 2024.0 benefits from multiple 3D Scene enhancements that improve the reality capture 

experience through the application, in addition to the Modernized image experience. They can be 

summarized below: 

▪ 3D Scene background: new options to customize the 3D scene 

▪ Stereo-Rendering: Cyclone 3DR is now compatible with stereo-screens 

▪ 3D Cursor: a new function is exposed to enable the 3D Cursor for a better 3D navigation in the digital 

environment 

▪ Camera animation improvements 

▪ Synchronization of multiple 3D scenes: an amazing way to visualize 3D data with different aspects 

on the reality 

▪ Compare side by side: a 1-click feature as a consequence from the synchronization of the scene 

▪ Capture View Updates: new options are released to deliver High Resolution screen visuals 

 

These features are available to users with the STANDARD license. 

 

Settings and generic scene updates 

All the settings related to the rendering and the 3D Scene have been moved into the main Display section. 

The new rendering features can be enabled and disabled from this part of the settings. 

 

 
 

Background / Skybox 

 

In the selection list from background, two new features are user-friendly for the 3D Experience: 

▪ Load custom image: it gives the user the capacity to load in the background a static image 

▪ Skybox: it loads a predefined sky-like image which has the benefit to be dynamic during the rotation 

of the scene 
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Scan To Pipe project with the new Skybox background 

 

Camera animations 

 

A new option “Enable camera animations” option is exposed. This feature is activated by default and brings 

a new 3D experience when changing the camera position and orientation with pre-defined actions like 

Zoom All, Zoom On, Pre-defined views (Top, Side, Bottom, Front, …). It becomes animated when changing 

from one view to the next one, which is more user-friendly and consistent with lots of 3D software 

application habits. 

 

 

Stereo Rendering 

 

A significant enhancement for 3D experts is the support of the stereo-rendering feature by Cyclone 3DR 

2024.0. For users who own stereo devices, the 3D experience can be extremely immersive and offers a 

total 3D path to process the data into Cyclone 3DR. 

 

The 3D PluraView © stereo-screen is in particular appropriate and compatible with Cyclone 3DR 2024.0. 

 

An option must be activated from the settings. 

 

 

Cursor type 

 

To improve the stereo-experience, the 3D cursor mouse has been added too and can be activated from 

the settings through the “Cursor type” selection of modes. 
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Synchronization of multiple 3D scenes 

With Cyclone 3DR 2024.0, multiple 3D scenes benefit from a new synchronization feature. When the 

synchronization capacity is turned on for multiple views, there is an automatic synchronization of the 

camera in matter of position, zoom, direction and mode (Perspective, Ortho, Fly, …). 

 

This feature offers a significant improvement for the 3D visualization experience and helps to understand 

the digital reality for all the applications. 

 

To active the synchronization between multiple scenes, three paths are possible: 

 

▪ The image navigation toolbar: with the release of the modernized image experience, users benefit 

from a quick access in the toolbar (Modernized image experience). When the user clicks on this quick 

access, the 3D scene is split in 2 synchronized scenes: one showing the camera, one showing the 3D 

environment. This feature is extremely convenient to extract images from both point clouds and 

images. Virtual Surveyor or Scan to Pipe are ideal examples for this usage. 

 

 

 

▪ View > Compare side by side: 1-click operation to do a visual comparison of 2 objects (View > 

Compare side by side). 
 

▪ The camera toolbar: when multiple 3D scenes are displayed, a new option at the bottom of the toolbar 

is available. The toggle button lets the user define which scenes are synchronized together. 
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The “synchronization” mode can display 

▪ The toggle to activate/disactivate the 

synchronization. 

▪ The list of visible scenes that can be 

selected/unselected for the synchronization. 

 

This feature is not available when the scene is 

constrained. For example, in a TOP or SIDE 

Ortho view, the camera orientation is locked. 
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View > Compare side by side 

This feature is a direct benefit from the support of the multi-view synchronization. It is just necessary to 

select 2 objects and to click on Compare side by side in the View menu. Automatically, the active 3D scene 

is split in 2 parts (1 object of each view) and the camera views are synchronized. 

 

This visualization feature is convenient to achieve visual comparison of reality. For example: 

▪ A design model and a point cloud 

▪ A heatmap and another object (BIM Model, Point Cloud, Mesh) 

▪ The same object with 2 different representations (RGB and classification for example for a point cloud) 

 

 
 

The 3D environment is displayed on two synchronized 3D views after a click on Compare side by side. In 

this example, the colormap from a BIM Inspection analysis and the original point cloud are displayed. 
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View > Capture View Updates 

The Capture View feature from the View menu is updated to offer a better experience for the creation of 

High-Resolution images and also to combine the possibilities between the previous Viewset and Capture 

View features. New options are now exposed. 

 
1. Select View: This feature is a direct access to the library of the existing saved viewsets of the 

3DR project. After clicking on the button, the list of available viewsets is unrolled and the saved 
view is displayed when selected. All the saved views from the report chapters of the project are 
also accessible from this link. 

2. Save View: After defining a view of the 3D Scene, users can now save a viewset directly from the 
Capture View feature, to have a direct access later in the project or to have a new visual for the 
report. 

3. Copy image: the active 3D view can be copied in the clipboard with this button. This feature offers 
time-saving when users want to enrich a documentation with Cyclone 3DR visuals. 

 

 
 

 
 

This feature is available to users with the STANDARD license. 

 

2 
1 

3 
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Quick measure > Distance between planes 

With Cyclone 3DR 2024.0, a new quick measurement tool is available in the quick measurement toolbar 

on the top right part of the 3D Scene: distance between planes. The purpose of this new tool is to offer 

users a new user-friendly way to measure distances normal to planar areas (like a wall or a floor for 

example) or normal to the vertical/horizontal planes. 

 

Manual clearance verification is a very convenient application for this new tool. 

 
1. Quick measure toolbar: It hosts the new “distance between planes” tool. 

2. Instructions: Maintaining the CTRL can force the measure along vertical or horizontal directions. 

3. Clicks on the 3D environment: to measure the distance 

 

 
 

The height under the beam can be measured in Cyclone 3DR for this scanned construction area. 

 

This feature is available to users with the STANDARD license. 

 

  

1 

2 

3 



 

69 
 

Texturing > Smart Texture > Filter ghost objects 

 

The Smart Texture feature benefits from an interesting improvement with the introduction of new filtering 

capacity for “ghost objects" to deliver more realistic textured meshes. 

 

The purpose of the texturing algorithm improvement is to remove unwanted textures on meshes for objects 

that can hide a background environment, that could be however more important for texturing applications. 

For example, when texturing a mesh for a street application, this improvement significantly removes the 

texture projection of objects like poles or road signs on the walls. 

 

The improvement is illustrated with the example below for the PLANT Industry. Thanks to the detection of 

ghost objects, the textures of the walls are more realistic in the latest Cyclone 3DR release. 

 

 
Cyclone 3DR 2023.1: WITH NO filtering capacities 

 

 
Cyclone 3DR 2024.0: WITH filtering capacities. The textures of the pipes are not projected on the 

background wall anymore. 

 

This improvement does not result in any changes in the usage of the Smart Texture feature.  

 

This feature is available to users with the SURVEY or PRO licenses. 

 



 

70 
 

Texturing > Edit Mask 

With Cyclone 3DR 2024.0 version, the new feature Edit Mask enlarges the panel of possibilities within the 

application for texturing workflows. It is now possible to directly edit masks of images for texturing needs. 

The purpose of the feature is to give users the ability to define the areas of camera images that are not 

used for the texturing. 

 

To edit the mask of images, it is necessary to select image objects (single images, multiple images or a 

set of images) and to click on Edit Mask command from the Texturing menu. 

 

The first image of the set is displayed on top of the 3D scene and a toolbar can be used to edit the mask 

(in blue color on the images below). It is possible to use the side arrows to navigate to the next/previous 

image of the set. 

 

 
 

 
 

The different capacities of the toolbar are described below: 

 
1. Drawing tools: Freehand and polygon fencing tools are typical of Cyclone 3DR existing tools. The 

brush tool displays a brush to draw/erase an area of the mask. The slider can be used to change 
the size of the brush. 

2. Eraser: This button is a toggle that exposes two modes: mask creation or removal. 

3. Reset/Undo/Redo 

4. Parameters: 2 settings can be changed, the colour and the transparency of the mask (adjusted 
by the slider). 

5. Validate/Cancel: to quit the Edit Mask command with or without saving. 

 

 

1 2 3 4 5 
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Example below: 

 

 
Pano-image from TRK scan before the edition of the mask 

 

 
Same pano-image with an edited mask 

 

After the edition of the masks, the next task in the workflow is Smart Texture application including a mesh. 

 

This feature is available to users with the SURVEY or PRO licenses. 
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Application > Notification center 

A new notification center is available directly from the top right corner of the main window of Cyclone 3DR 

application. This notification center is independent from each 3DR project and can expose the most recent 

notifications that were announced to the users. The notification center is particularly useful in the case of 

a long calculation which finished while users were not in front of the computer. In this case, the user can 

still get access to the latest notification from Cyclone 3DR. 

 

 
 

The features of the notification centers are the following ones: 

 
1. Shortcut access: next to Check Update icon, one click hides or displays the notification center. 

2. Dialog: a new dialog is available on the right part of the scene. It can be undocked to a floating 
position, and it can be collapsed like the treeview on the left for example. 

3. Filtering tool: field to allow users to look for notifications according to key words. 

4. Options: quick buttons to collapse/uncollapse the detailed information of each notification 

5. Notification details: each notification contains some information like the reported issue, the time 
and date and the name of the 3DR project. 

 

This feature is available to users with the STANDARD license. 

 

1 

3 
4 

2 

5 
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Scripting > New user-friendly dialog experience 

Scripting benefits from an interesting new feature that will contribute to the democratization of its usage: 

the capacity to build customized dialog box to execute any tasks, with the same capacities as regular 

dialog box of Cyclone 3DR regular features. Thanks to this feature, the script experience will be much 

easier for every user of scripts, in particular when users take the script program from a 3rd party person or 

entity. 

 

To build and to execute a dialog from a new script (in JavaScript language), all the specifications have 

been explained in the script API documentation and are illustrated with examples. For non-expert users, it 

is very convenient to get inspired from the codes of the predefined scripts that are accessible and public. 

 

Part of the features of the new dialog experience, it is now possible to specify many items in the automatic 

dialog box: 

▪ Texts like title, sections, comments, tooltips, … 

▪ Widgets like checkboxes, radio buttons, fields, buttons … 

▪ Images for illustration 

 

 
Example to introduce some the new dialog created from a customized script with user-defined title, 

section, choice of radio buttons, tooltip. 

 

All the predefined scripts of Cyclone 3DR benefit 

from this user-friendly experience. It is illustrated 

with the Curb Extraction pre-defined script. 

 

 

This feature is available to users with the STANDARD license. 
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Improvements 

 
▪ Analysis > Inspection Notes: A summary table is added at the beginning of the report (similar 

to Visual Notes). 

 
 

▪ Camera > Zoom All: The zoom all action is more accurate and also consider clipping objects 
when adjusting the camera position. 

 
▪ Clean > Edit Polyline: A new arc-drawing capacity is enabled. This improvement is described 

in the New arc-drawing feature section of the Release Notes 

 

▪ Script: GetBoundingBox now accepts a matrix to compute aligned bounding box on a given 
coordinate system. 

 

▪ Script > SCloud: The output density is now stored as an specific extradata in the ouput clouds 
(ComputeDensityFromSphere, ComputeDensityFromNearestPoints). Detailed in the Point 
cloud metadata display features section of the Release Notes 

 

▪ Send to BricsCAD: Compatible with BricsCAD v24. 

 

▪ Settings: All display related settings are exposed in a new section “Display” instead of the 
previous section “Object”  

Bug Fixes 

 

In 2024.0.0 release: 

 

▪ Analysis > Compare Inspect Sections: The “maximum distance” option was not taken into 

consideration when inspecting a deviation along a direction, for Section vs Section comparison 

and for Section vs Geometry comparison. Fixed. 

 

▪ Analysis > Gridded Inspection: The “pass through point” option did not consider the active UCS 

if different from WCS. Fixed. 
 

▪ Extract > Circle > Region Grow: Wrong extraction happened with CAD objects. Fixed. 

 

▪ Extract > Intersection between meshes: The command could return no results in spite of the 

fact that the meshes were intersecting. Fixed. 
 

▪ File > Import BIM: Some elements were imported with a wrong origin information. Fixed. 
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▪ File > Send to AutoCAD: The gradient unit wasn’t taken into account when inspected polylines 

were sent from Cyclone 3DR to AutoCAD. Fixed. 
 

▪ Script: State of IgnoreRoadValue option was inverted in SSurveying.CompareCrossSections. 

Fixed. 

 

 

Deprecated features 

Leica Geosystems strives to provide support for the widest array of operating systems and file formats 

possible as is reasonable given current technologies and support from third-party partners. 

With each release, we review our list of currently supported formats and operating systems in line with 

industry trends and announced product terminations. 

 

Leica Geosystems may add or terminate support for a file format during any release. Obsolete operating 

systems will be supported for six months after their announced termination or the next major software 

release, whichever comes first. Server products will be supported in alignment with Leica’s Client License 

Manager (CLM) supported servers to guard users against incompatibility. 
 

In Cyclone 3DR 2024.0.0:  

▪ File > Import: DotProduct format (*.dpl) for point clouds is not supported anymore. 

 

▪ File > Import LGS: LGSx is replacing LGS. LGS is still supported within Cyclone 3DR 2024.0. 

 

▪ File > Export LGS: Not supported anymore and replaced by LGSx. 

 

▪ View > 2D Preview: The command was removed. The 2D Preview capacity remains available for 

Tunnel/Road application in the new series of workflows for Profile Extraction and Analysis and in 

the TANK Inspection workflow. 
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Generic specifications 

Leica Cyclone 3DR 2024.0 Compatibility 

Cyclone 3DR is compatible with CLM 2.14.0 and higher.  

Cyclone 3DR is compatible with JetStream ENTERPRISE 1.3 and higher.  

Cyclone 3DR is compatible with LGS/LGSx files. 

Cyclone 3DR is compatible with Cyclone ENTERPRISE 2022.0 and higher. 

Cyclone 3DR is compatible with Cyclone REGISTER 360 2021.1 and higher. 

Cyclone 3DR is compatible with Cyclone IMP databases from Cyclone 6.0 or higher, however 

improved rendering will only be seen with IMPs from Cyclone 9.3 or higher. 

 

Recommended Computer Specifications 

 

Regular workflows in desktop application: 

CPU: 2 GHz Dual Quad Core i7 or higher (i5 minimum) 

RAM: minimum 16 GB or more for 64-bit OS 

Graphic Card: NVidia Quadro or GeForce 1 GB (with OpenGL support, versions 4.3 or higher) 

Operating system: Microsoft Windows 7, 8, 10, 11 (64 bits supported) 

Hard Disk: 3 GB free disk space 

 

 

Tablet device for Touch Mode: 

Microsoft Surface PRO Core i7 1.5 GHz – 16GB RAM. 

 

Minimum specifications for Auto-classification (in addition to other recommended specifications 

for the desktop application: 

RAM: minimum 32 GB  

Graphic Card: NVidia with GPU capabilities  

- Compute capability: 5.0 or higher 

- Minimum GPU memory: 4 GB 

Hard Disk:10 GB free disk space 

CUDA® 11.8 Toolkit (from NVidia). The 11.8 version of CUDA is mandatory for Auto-

Classification. 

 

  

https://developer.nvidia.com/cuda-gpus
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Installation and Licensing Recommendations 

Installation update Procedure  

 

1. Launch the Cyclone 3DR EXE and follow the instructions in the Setup Wizard 

 

 
 

2. Select the option to update Cyclone 3DR (or repair if you want to change installing options) 

 

 

 
3. Complete the installation by selecting “Finish”. 

 

Licensing Setup  

1. Once you have installed Cyclone 3DR, open the Client License Manager for Floating Licenses 

via Cyclone 3DR (Home/Settings/License) or via the program located here:  

Start Menu | All Programs | Leica Geosystems | Client License Manager   
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*NOTE* Be sure to choose the CLM Floating option (there are two CLM options 

and the Nodelocked CLM will not activate your license)  

2. Click “Add”.  

 
 

 

3. Enter your Entitlement ID (EID) in the field (copy / paste). To enter multiple EIDs separate them 

with a semicolon ";" and no space.  
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4. After you have entered your EID, click on the “ADD” button in the bottom right of the page 

 

 
 

5. Once your licenses are activated you can close CLM and launch or return to Cyclone 3DR.  
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6. Go to Home / Settings and select License. 

 

 
 

7. If you have entered the EID inside your local CLM, select Localhost. If the license is on a 
dedicated server, enter the server’s name in Server Address. 
 

 
 

 
8. You can select the features you want to check out from CLM. The available options to checkout 

will correspond to the options you purchased which are contained in your EID. 
 



 

81 
 

 
 

9. Once the options are selected, click on Activate license. 

 

Licensing 

All users with valid CCP or CCP which was valid as of 17 December 2023 for Cyclone 3DR, can run this 

new version of Cyclone 3DR. 

 

All users with valid CCP or CCP which was valid as of 17 December 2023 for 3DReshaper, can run this 

new version of Cyclone 3DR with no new license required. 

 

Users with 3DReshaper licenses with expired CCP must migrate to Cyclone 3DR in order to continue to 

access updates and support. Please contact your sales or support personnel for more information.  
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Known Issues 

 

▪ The Documentation Center is only available in English. 

▪ Some CAD import and export issues might happen. For example, when exporting a cloud in DXF, 

some entities might be missing. To avoid this, it is preferable to use the Send to AutoCAD option. 

▪ If DXF can be imported with a standard version, DWG requires the AEC or PRO Edition. One 

workaround is to use the 3DSend command from AutoCAD to Cyclone 3DR. 

▪ .RSH files are natively compatible with Cyclone 3DR, and the last version of 3DReshaper is 

compatible with .3DR files (with a limit on textures and CAD objects). 
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Leica Cyclone 3DR interoperability 

Import / Export supported file formats 

Please reference the Cyclone 3DR Technical Specification for a complete list of supported file types per 

license.  

 

 Import Export 

Point 

Cloud 

Files ASCII (*.asc, *.csv, *.xyz, *.yxz…) 

Leica Geosystems (*.pts, *.ptx) and 

LGS/LGSX (*.LGS/LGSx) 

Leica Nova MS50/60 (*.sdb, *.xml) 

ShapeGrabber (*.3pi) 

3DReshaper binary file (*.nsd) 

AutoDesk DXF (*.dxf) 

STL (*.stl) 

Polyworks (*.psl) 

Leica T-Scan + Steinbichler (*.ac) 

LIDAR data (*.las; laz) 

Other ASCII (*.*) 

Zoller and Fröhlich *(.zfs - *.zfc) 

PLY points without triangles (*.ply) 

ESRI ASCII (raster format *.asc) 

FARO (*.fls - *.fws) 

POLYWORKS (*.psl) 

E57 (*.E57 files) 

LandXML files (*.xml), RDBX 

ASCII FILES (*.asc, *.csv…) 

Binary files (*.nsd) 

Leica Geosystems (*.pts, *.ptx, *LGS/LGSx) 

E57 (*.e57) 

IGES (*.igs) 

LAS (*.las) 

LAZ (*.laz) 

Autodesk DXF (*.dxf) 

 

Mesh STL format (*.stl) 

Binary PBI format (*.pbi) 

DXF 3Dface format (*.dxf) 

Ascii POLY format (*.poly) 

OBJ format (*.obj) 

Ascii Leica format (*.msh) 

OFF files (*.off) 

PLY (*.ply) 

GLB format (*.glb, *gltf) 

 

Ascii and binary STL format (*.stl) 

Binary PBI format (*.pbi) 

DXF 3Dface format (*.dxf) 

Ascii POLY format (*.poly) 

Vertices only (*.asc) 

DXF polyline (*.dxf) 

Ascii Leica format (*.msh) 

PLY (*.ply) 

LandXML (*.xml) 

OBJ format (*.obj) 

GLB format (*.glb) 

FBX format (*.fbx) 

IFC / IFCSite type (*.ifc, *.ifczip) 
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Contour / 

Section 

IGES format 

DXF polyline format 

Binary MLI format (*.mli) 

 

IGES format 

DXF polyline format 

Binary MLI format (*.mli) 

ASCII formats 

CAD / BIM 

Models 

IGES 

STEP 

DWG 

IFC 

RVT 

IGES 

STEP 

DXF 

IFC (Piping models) 

Project Cyclone 3DR (*.3dr) 

DXF - DWG 

XML 

Cyclone ModelSpace View (from IMP) 

JetStream Enterprise project  

Cyclone 3DR (*.3dr) 

DXF 

PDF 3D 

SKETCHFAB 

Report  PDF 

CSV 

BCF 

Image BMP 

JPEG 

JPG 

PNG 

Ortho-image including georeferencing 

information as TXT file 

JPG 

JPEG 

BMP 

PNG 

TIF (Ortho-image only) 
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Send To / Send From 

 

Cyclone 3DR provides “SendTo” features as well to import and export certain kinds of data with third-party 

products. More information is available in Cyclone 3DR documentation center (from the software help 

menu). 

 

 Send From Send To 

Point Cloud - - 

Mesh / 

Surfaces 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

Contour / 

Section / 

Points 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

CAD Model AUTODESK AutoCAD 

HEXAGON BricsCAD 

- 

Image - AUTODESK AutoCAD (ortho-image) 

HEXAGON BricsCAD 

 

The following commands in Cyclone 3DR include a direct “Send to” capacity that provides the possibility 

to export the outputs in different layers in the CAD 3rd party software product: 

 

Menu Feature Comment 

Extract Contour Lines 
1 layer for standard contour lines and values. 

1 layer for major contour lines and values. 

Extract Scan to Plan 1 layer per slice (floorplans or sections) 

Extract Virtual Surveyor 
1 layer per layer created in 3DR Virtual Surveyor 

project. 

Extract Scan to Pipe 1 layer per pipe trace 

Analysis 
Gridded Inspection 

Surface Analysis with a Grid 

Points and values on grid can be directly sent to CAD 

SW product. Sent to active layer. 

Texturing Extract Orthoimage Sent to active layer. 

Analysis 

Profile Extraction 

Profile 3D Inspection 

Profile 2D Inspection 

1 layer for 2D Grids 

1 layer for inspection objects 

1 layer per section 

1 layer per axis points 

1 layer per axis point quotations. Tank 2D Preview / Export 
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Compatibility with native JetStream point clouds 

The following commands can use native JetStream point clouds (LGS/LGSX files or connection to Cyclone 

CORE, Cyclone REGISTER 360, Cyclone ENTERPRISE) as inputs. In other words, it is not required to 

proceed a CloudWorx > Convert project step prior to execution of the listed features. 

 

 

Menu Feature Comment 

Extract Virtual Surveyor 
No selection is required for this feature. Thus, it can 

be used for any kind of object in a 3DR project. 

Extract Scan to Plan Improvement from Cyclone 3DR 2024.0 

Surface 

Modeling 
Scan to Mesh 

A clipping box as input is recommended to define an 

area of interest. 

Analysis Stockpile  

Analysis Visual Notes 
No selection is required for this feature. Thus, it can 

be used for any kind of object in a 3DR project. 

 

The functionalities of the menus View, CloudWorx and Script can obviously be used for JetStream point 

clouds. 

 

Connect to Cyclone FIELD360 

The connection from Cyclone FIELD360 to Cyclone 3DR (2024.0 version) projects is limited to TLS 

sensors: 

 

▪ P-XX series 

▪ RTC 360 

▪ BLK 360 (the two generations) 
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Export BCF tickets 

The following commands embed the capacity to export BCF (BIM Collaboration Format) files that contain 

information from IFC model for an open-BIM experience with other software and BIM solutions. 

 

Cyclone 3DR 2024.0 support BCF 2.1 format (export). 

 

Menu Feature Comment 

Analysis Inspection Notes 

Input: Inspected BIM Model 

 

Feature to report issues from an inspection and that gives the ability to create 

manual notes that contains screenshots, images from disk, labels and 

deviation values (attached CSV), clipping object information and coordinates 

and orientation of viewpoint; but also, a user-defined title, an assignment (email 

address), a comment and a priority. 

 

Analysis Visual Notes 

Input: BIM Model 

 

Feature to report comments and notes based on visual analysis of a BIM 

design model and the captured reality. The feature gives the ability to create 

manual notes that contains screenshots, images from disk, distance 

measurements, clipping object information and coordinates and orientation of 

viewpoint; but also, a user-defined title, an assignment (email address), a 

comment and a priority. 

 

Analysis Clash 

Input: A point cloud and a BIM Model 

 

Feature to report clashes that contain screenshot, clash status (clash, no clash 

or undefined) and a comment. 

All tickets refer to the same assignment (email address). 

 

Analysis 
Progress 

Monitoring 

Input: A point cloud and a BIM Model 

 

Feature to report the progress monitoring analysis. 

Default export contains a summary (progress distribution between installed, in 

progress, not installed and no data). 

Ability to customize the export and to create additional single tickets per 

analyzed element depending on their status (installed, not installed, in 

progress). 

All tickets refer to the same assignment (email address). 

 

 

 

 

 

 

 

 



 

88 
 

Classification experience 

Exchange formats for classification 

Classification of point clouds is saved and supported after Import/Export for the following formats: 

 

E57, LAS, LAZ, LGS/LGSx 

Models 

Within the 2024.0 version of Cyclone 3DR, the following classification models are exposed in the Auto-

Classification feature 

 

Name Application 

Used 

scanners 

for training 

Other recommendations 
Features using 

class information 

Indoor 

Generic 
Indoor – All All 

Relevant for Scan to Model 

workflows. 
 

Indoor 

Construction 

Site 

Indoor – All All 

Relevant for “Scan to Verify” 

workflows for as-built 

verification for example. 

Progress 

Monitoring 

Outdoor for 

TLS 
Outdoor – All TLS 

Generic classification that 

can be used with other 

sensor types. 

 

Heavy 

Construction 

UAV 

Outdoor - 

Heavy 

Construction 

UAV 

Sensors 

Recommended for Heavy 

Construction environment 

only. Can be used with other 

sensor types. 

 

Mobile BLK 

Filter People 
All 

BLK2GO 

and 

BLKARC 

Recommended with BLK2GO 

and BLKARC only. 

Clean moving people and 

objects. 

 

Road for MMS Roads TRK series 

Recommended with all MMS 

sensors and useful withTLS 

scanners like RTC360 and 

BLK360 to do extraction. 

 

 

 


